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XTGUI

 Client/Server applicationClient/Server application
 Server runs on SMWServer runs on SMW
 Client runs on SMW or any network attached computer Client runs on SMW or any network attached computer 

systemsystem



Software Distribution

 The xtgui client and server software is distributed with the 
SMW software release. Both the xtgui server and client are 
normally installed on the SMW. 

 The xtgui server automatically starts with the rest of the 
CRMS daemons. The xtgui client may be run on the SMW, or 
downloaded and operated from a remote system.

 To package the xtgui for remote download, run the script: 
/opt/cray/bin/packagextgui



XTGUI Server

 Started with other CRMS daemons
 Obtains status of all XT components from CRMS state 

manager
 Listens for CRMS events
 Sends each client a copy of XT component status upon client 

startup



XTGUI ServerXTGUI Server

 Forwards selected CRMS events to clientsForwards selected CRMS events to clients
 Responds to client requestsResponds to client requests
 Monitors selected log files on the SMW, sending new entries Monitors selected log files on the SMW, sending new entries 

to clientsto clients
 Runs xtcli commands on behalf of clientsRuns xtcli commands on behalf of clients



Log FilesLog Files

 Server startup/error log:Server startup/error log:
• /opt/craylog/xtguiserver.out /opt/craylog/xtguiserver.out 
• Contains server operational status messages.Contains server operational status messages.

 Server application log:Server application log:
• /opt/craylog/RsmsJServer.log.mmddyy /opt/craylog/RsmsJServer.log.mmddyy 
• Contains copy of significant xtgui client related events, such as  xtcli Contains copy of significant xtgui client related events, such as  xtcli 

commands executed on behalf of clientscommands executed on behalf of clients 



Properties Files

 /opt/cray/etc/RsmsJServerProperties.txt/opt/cray/etc/RsmsJServerProperties.txt
 Contains entries to configure various server optionsContains entries to configure various server options
 Example:Example:

• # The buffer size (number of lines to read) used when “tailing" server # The buffer size (number of lines to read) used when “tailing" server 
• #log files.#log files.
• server.watchedFileBufferSize=200server.watchedFileBufferSize=200
• # The frequency with which log files are examined for new data# The frequency with which log files are examined for new data
• server.watchedFileLatencyMilliseconds=5000server.watchedFileLatencyMilliseconds=5000



SecuritySecurity

 Two modes of server/client interaction:Two modes of server/client interaction:
• Standard mode: Standard mode: 

 Any network attached xtgui client may connectAny network attached xtgui client may connect

• SMW only mode: SMW only mode: 
 Connections from xtgui clients running on SMWConnections from xtgui clients running on SMW

 Controlled by “SMWOnly” option in server startup scriptControlled by “SMWOnly” option in server startup script



SecuritySecurity

 Password level access control and encrypted data Password level access control and encrypted data 
communications from remote sites my be accomplished by communications from remote sites my be accomplished by 
using a combination of ssh and vncserver plus vncviewerusing a combination of ssh and vncserver plus vncviewer

1.1. Run vncserver on secure workstation or SMWRun vncserver on secure workstation or SMW

2.2. Ssh into secure site from remote locationSsh into secure site from remote location

3.3. Use vncviewer to run the xtgui on secure platformUse vncviewer to run the xtgui on secure platform

4.4. Xtgui application will display on the remote systemXtgui application will display on the remote system





XTGUI ClientXTGUI Client

 Color-coded visual representation of all major XT system Color-coded visual representation of all major XT system 
components, clearly illustrating their current statuscomponents, clearly illustrating their current status

 Supports all xtcli commands, except “boot”Supports all xtcli commands, except “boot”
 Runs on any workstation with network access to the SMWRuns on any workstation with network access to the SMW
 May be operated in “view only” mode, where no XT May be operated in “view only” mode, where no XT 

configuration actions are allowedconfiguration actions are allowed
 Scales from small to very large systemsScales from small to very large systems



Starting The ApplicationStarting The Application

 If the application is started with a host name argument, then it If the application is started with a host name argument, then it 
will attempt to contact the xtgui server on that host, at the will attempt to contact the xtgui server on that host, at the 
default port (4095)default port (4095)

 If no host name argument is provided, a connection screen is If no host name argument is provided, a connection screen is 
shown:shown:



Six Major ViewsSix Major Views

 System MapSystem Map
 Cabinet DetailCabinet Detail
 Component DetailComponent Detail
 Error ListError List
 Event LogEvent Log
 Console LogConsole Log



Major Views



System MapSystem Map

 The system map is a two dimensional representation of the The system map is a two dimensional representation of the 
Cray XT cabinet layoutCray XT cabinet layout

 Each rectangle represents one cabinetEach rectangle represents one cabinet
 A warning or error condition on any component within a A warning or error condition on any component within a 

cabinet is indicated by a differentially colored rectangle within cabinet is indicated by a differentially colored rectangle within 
the cabinet representationthe cabinet representation



Cabinet Detail Map

 The cabinet detail map shows contents of the cabinet The cabinet detail map shows contents of the cabinet 
selected from the system mapselected from the system map

 The status of the cabinet, it's blades, CPUs and Cray The status of the cabinet, it's blades, CPUs and Cray 
Seastars are shownSeastars are shown



Component Detail

 Selecting a cabinet from the system map, or a blade from the Selecting a cabinet from the system map, or a blade from the 
cabinet detail map, causes the component detail tab to be cabinet detail map, causes the component detail tab to be 
filled with information on the selected objectfilled with information on the selected object

 Selecting table column headers will cause the table to be Selecting table column headers will cause the table to be 
sorted on the contents of that columnsorted on the contents of that column



Component Detail

 Components may be selected with the left mouse buttonComponents may be selected with the left mouse button
 The right mouse button brings up a menu with the following options:The right mouse button brings up a menu with the following options:

View Console OutputForce Slot Down

Slot DownSlot UpSet Empty

ReserveForce Power DownPower Down

Power UpPartitionLock

HaltEnableDisable

DiagnosticsCreate NodelistClear Reserve

All menu options are context sensitive, so the chosen option will effect only those All menu options are context sensitive, so the chosen option will effect only those 
components on which such an operation is possible, given the type and state of components on which such an operation is possible, given the type and state of 
the selected components.the selected components.



Component Detail Menu OptionsComponent Detail Menu Options

 When a menu option is chosen, the user is always shown a When a menu option is chosen, the user is always shown a 
confirmation dialog prior to the action being performedconfirmation dialog prior to the action being performed 



Component Detail Menu Options

 Clear Reserve:  Clear Reserve:  
• To release a reserved component and return it to normal operationTo release a reserved component and return it to normal operation
• Once a component is reserved, it will not accept new jobs, but any Once a component is reserved, it will not accept new jobs, but any 

jobs already running on the component are completed in an orderly jobs already running on the component are completed in an orderly 
fashionfashion

 Create NodelistCreate Nodelist
• This option is similar to the Save Node List option on the File menuThis option is similar to the Save Node List option on the File menu
• The difference is that the File menu Save Node List option creates a The difference is that the File menu Save Node List option creates a 

list of all nodes in all cabinets in the system, while this option creates list of all nodes in all cabinets in the system, while this option creates 
a list of only the selected nodesa list of only the selected nodes

• Selecting a cabinet or blade adds all of their component nodes to the Selecting a cabinet or blade adds all of their component nodes to the 
nodelist, while selecting individual nodes adds only the selected nodelist, while selecting individual nodes adds only the selected 
nodes to the nodelistnodes to the nodelist

• By default, this file is written to your home directory and has the By default, this file is written to your home directory and has the 
name RsmsNodeList-MMDD-HHMM.SS.txtname RsmsNodeList-MMDD-HHMM.SS.txt



Diagnostics Menu OptionsDiagnostics Menu Options

 The list of diagnostic optionsThe list of diagnostic options
 includes: includes:

• cpuburncpuburn

• memtestmemtest

• seacheck seacheck 

• sealinksealink

• test30mtest30m

• testlongtestlong

• threadstorm testthreadstorm test

• threadstorm ram testthreadstorm ram test

 The diagnostic options offered will be dependent upon the The diagnostic options offered will be dependent upon the 
type of selected components, as well as their current statetype of selected components, as well as their current state



Diagnostics Operation

 A progress dialog window is shown during the course of the A progress dialog window is shown during the course of the 
diagnostic testdiagnostic test



Diagnostics Operation

 When the diagnostic test completes, a diagnostic summary When the diagnostic test completes, a diagnostic summary 
tab is added to the xtgui display tab is added to the xtgui display 

 A right mouse click on this window will bring up a menu with A right mouse click on this window will bring up a menu with 
the options to:the options to:
• close tabclose tab
• close all diagnostics tabsclose all diagnostics tabs



Detail Menu OptionsDetail Menu Options

Locks a component manually. Components are locked Locks a component manually. Components are locked 
automatically when a command that can change their state is automatically when a command that can change their state is 
running. As the command is started, the state manager locks running. As the command is started, the state manager locks 
the component so that nothing else can affect the component's the component so that nothing else can affect the component's 
state while the command is running. When a manager is state while the command is running. When a manager is 
finished with a command, it unlocks the component finished with a command, it unlocks the component 
automatically. If the manager for some reason fails to unlock automatically. If the manager for some reason fails to unlock 
the component, it can be unlocked manually using the Actions the component, it can be unlocked manually using the Actions 
menu Show Locks option.menu Show Locks option.

Lock

Stop a component immediately. The component immediately Stop a component immediately. The component immediately 
ceases operation and any data or processes running on the ceases operation and any data or processes running on the 
component are lost.component are lost.

Halt

Re-enable a component and return it to normal operation.Re-enable a component and return it to normal operation.Enable

If links, nodes, or Cray Seastar chips have hardware problems, If links, nodes, or Cray Seastar chips have hardware problems, 
you can mark the component as downed by the administrator you can mark the component as downed by the administrator 
and prevent its being allocated.and prevent its being allocated.

Disable



Detail Menu OptionsDetail Menu Options

Reserve a component. Once a component is reserved, it will Reserve a component. Once a component is reserved, it will 
not accept new jobs, but any jobs already running on the not accept new jobs, but any jobs already running on the 
component are completed in an orderly fashion.component are completed in an orderly fashion.

Reserve

Force a power down of a component. If you choose this option, Force a power down of a component. If you choose this option, 
the power manager ignores the operational state of the the power manager ignores the operational state of the 
components that are being acted upon.components that are being acted upon. 

Force 
Power 
Down

Power down a component. Powering down a cabinet powers Power down a component. Powering down a cabinet powers 
down all components within the cabinet, including the L0 down all components within the cabinet, including the L0 
controllers.controllers.

Power 
Down

Power up a component. Power commands are hierarchical; Power up a component. Power commands are hierarchical; 
that is, there are a number of ways to power up or power down that is, there are a number of ways to power up or power down 
a lower-level component. For example, to power up a node, a lower-level component. For example, to power up a node, 
you can power it up directly or power up a component of which you can power it up directly or power up a component of which 
it is a part.it is a part.

Power Up



Detail Menu OptionsDetail Menu Options

Force the blade to power down regardless of operational Force the blade to power down regardless of operational 
state.state.

Force Slot Down

Power down all components on a blade including the L0 Power down all components on a blade including the L0 
controller.controller.

Slot Down

Power up all components on a blade.Power up all components on a blade.Slot Up

Set a selected component to the empty state. This is Set a selected component to the empty state. This is 
typically done when a component, usually a blade, is typically done when a component, usually a blade, is 
physically removed from the system. When a component physically removed from the system. When a component 
is set to empty, the system ignores it and routes around is set to empty, the system ignores it and routes around 
it. To return a component to normal operation after it has it. To return a component to normal operation after it has 
been marked as empty -- for example, after a been marked as empty -- for example, after a 
replacement blade has been installed , select the Enable replacement blade has been installed , select the Enable 
option from the menu.option from the menu.

Set Empty



Detail Menu Option:  View Console OutputDetail Menu Option:  View Console Output

 Display console log messages from selected nodesDisplay console log messages from selected nodes
 A right mouse click on this window will bring up a pop up menu with the A right mouse click on this window will bring up a pop up menu with the 

options options 

1) show filter targets   1) show filter targets   

2) close tab   2) close tab   

3) close all filter console tabs.3) close all filter console tabs.



Error ListError List

 All components with a current warning or alert status, are shown in the All components with a current warning or alert status, are shown in the 
error listerror list

 Selecting table column headers will cause the table to be sorted on the Selecting table column headers will cause the table to be sorted on the 
contents of that columncontents of that column

 Components may be selected with the left mouse buttonComponents may be selected with the left mouse button
 The right mouse button brings up a menu with the following options:The right mouse button brings up a menu with the following options:

• Clear WarningClear Warning
• Clear AlertClear Alert 



Event Log

 The event log displays recent information sent to the files that The event log displays recent information sent to the files that 
the xtgui server is configured to watch, as well as all the xtgui server is configured to watch, as well as all 
commands executed by the xtgui server on behalf of the xtgui commands executed by the xtgui server on behalf of the xtgui 
clientclient



Console LogConsole Log

 The console log displays console log messages from all Cray The console log displays console log messages from all Cray 
XT nodesXT nodes

 Display of console output from selected nodes may be Display of console output from selected nodes may be 
accomplished through the “view console output” menu option accomplished through the “view console output” menu option 
on the component detail popup menuon the component detail popup menu



Toolbar Menus

 Various actions and configuration options my be accessed by using Various actions and configuration options my be accessed by using 
the options on the toolbar menus in the upper left-hand corner of the the options on the toolbar menus in the upper left-hand corner of the 
XTGUI window. These menus and their options are:XTGUI window. These menus and their options are:

Show Locks

Import/Export Sections

Show Server Status

Show Boot Configuration

Show Active Commands

Show Components

Actions

Partition Configuration

ConnectionExit

GeneralSave Node List

PreferencesFile



File MenuFile Menu

 Save Node List: Save Node List: 
• Create a text file listing all CPUs in the system, marking each "n" for Create a text file listing all CPUs in the system, marking each "n" for 

empty or disabled, "i" for service, "c" for compute.  empty or disabled, "i" for service, "c" for compute.  For example:For example:
 c0-0c0s0n0   ic0-0c0s0n0   i
 c0-0c0s0n1   nc0-0c0s0n1   n
 c0-0c0s0n2   nc0-0c0s0n2   n
 c0-0c0s0n3   ic0-0c0s0n3   i
 c0-0c0s1n0   cc0-0c0s1n0   c
 c0-0c0s1n1   cc0-0c0s1n1   c

• This text file is saved in the users home directory and the naming This text file is saved in the users home directory and the naming 
convention is: RsmsNodeList-mmdd-hhmm.ss.txtconvention is: RsmsNodeList-mmdd-hhmm.ss.txt

 Exit: Exit: 
• Exit the xtgui application.Exit the xtgui application.



Actions Menu:  Show ComponentsActions Menu:  Show Components

 This option presents a dialog that allows the user to select This option presents a dialog that allows the user to select 
physical or logical groupings of components:physical or logical groupings of components:



Show ComponentsShow Components

 If “Boot Nodes” was chosenIf “Boot Nodes” was chosen
• the cabinets containing boot nodes would be selected in the system the cabinets containing boot nodes would be selected in the system 

mapmap
• the cabinet detail window would indicate which blades within a the cabinet detail window would indicate which blades within a 

cabinet contained the boot nodescabinet contained the boot nodes
• the component detail table would be populated with boot node the component detail table would be populated with boot node 

component records.component records.



Actions Menu:  Show Active CmdsActions Menu:  Show Active Cmds

 This option displays a table of currently active commands that This option displays a table of currently active commands that 
have been started by the xtgui clienthave been started by the xtgui client



Actions Menu:  Show Boot ConfigurationActions Menu:  Show Boot Configuration

 This option displays a dialog that provides way to show the This option displays a dialog that provides way to show the 
boot configuration of all Cray XT partitionsboot configuration of all Cray XT partitions



Actions Menu:  Show Server StatusActions Menu:  Show Server Status

 This option displays a window that provides information on This option displays a window that provides information on 
the xtgui server process and lists all connected xtgui clientsthe xtgui server process and lists all connected xtgui clients



Actions Menu:  Import/Export SectionsActions Menu:  Import/Export Sections

 This option displays a dialog allowing the user to import or This option displays a dialog allowing the user to import or 
export sections of the Cray XT system. export sections of the Cray XT system. 

 The option is enabled only if more than one section has been The option is enabled only if more than one section has been 
defined.defined.



Actions Menu:  Show LocksActions Menu:  Show Locks

 This option displays all currently active session locks. This option displays all currently active session locks. 
 A left mouse click selects rows in the table and a right mouse A left mouse click selects rows in the table and a right mouse 

click pops up a menu allowing display of the effected click pops up a menu allowing display of the effected 
components for each session and the option of dismissing the components for each session and the option of dismissing the 
lock.lock.



Preferences Menu:  General PreferencesPreferences Menu:  General Preferences

 This option displays a dialog that allows the configuration of This option displays a dialog that allows the configuration of 
three options: three options: 
1.1. Mouse over mode (which means to automatically switch the cabinet Mouse over mode (which means to automatically switch the cabinet 

detail window to the cabinet that the mouse is currently hovering detail window to the cabinet that the mouse is currently hovering 
over).over).

2.2. Deiconize on warning/alert.Deiconize on warning/alert.
3.3. Tool tip delay.Tool tip delay. 



Preferences Menu:  Connection

• This option displays a dialog which allows configuration of the This option displays a dialog which allows configuration of the 
host name and port number of the primary and secondary host name and port number of the primary and secondary 
SMW systems to connect toSMW systems to connect to



Preferences Menu:  Partition ConfigurationPreferences Menu:  Partition Configuration

• This option presents the partition configuration dialogThis option presents the partition configuration dialog



Properties FileProperties File

 The xtgui client uses the file RsmsClientProperties.txt to store The xtgui client uses the file RsmsClientProperties.txt to store 
configuration optionsconfiguration options

 This file is copied into the users home directory the first time that the This file is copied into the users home directory the first time that the 
application runsapplication runs

 Examples of the type of configuration options that are stored in this file:Examples of the type of configuration options that are stored in this file:
• client.primaryPort=4095client.primaryPort=4095
• client.secondaryHost=client.secondaryHost=
• client.rmiTimeoutMilliseconds=120000client.rmiTimeoutMilliseconds=120000
• client.primaryHost=snowdriftclient.primaryHost=snowdrift
• client.toolTipDelay=0client.toolTipDelay=0
• client.portNumber=0client.portNumber=0
• client.heartBeatDelay=5000client.heartBeatDelay=5000
• client.deiconize=falseclient.deiconize=false
• client.heartBeatFrequency=5000client.heartBeatFrequency=5000
• client.secondaryPort=client.secondaryPort=
• client.mouseOverMode=falseclient.mouseOverMode=false



Online HelpOnline Help

 Selecting the Help menu on the toolbar, displays the online Selecting the Help menu on the toolbar, displays the online 
help documenthelp document


